Printing
Printing overview
When you create a document or enter data into a spreadsheet, you may want to see what your work looks like in print. To do this, you must install a printer. The printer might be attached directly to your computer, or it may be a shared network printer located in a common copy room. Once installed, the printer will be listed in the Printers folder as well as in the Print dialog box of the program you are using.
A variety of settings and print options are available once the printer is installed on your computer. For example, you can share your printer with another user or set up a separator page so you can easily identify your document among other documents. You can also change options that specifically affect how a document is printed. For example, you can change the page layout from portrait to landscape or you can change the number of copies that are printed.
To print a document
 1.
Open the document you want to print. 
 2.
On the File menu of the program you are using, click Print. 
Notes

In the Print dialog box you can see the number of documents waiting to print on any printer installed on your computer by right-clicking the printer in Select Printer and then clicking Open. 

If you are logged on to a Windows 2000 domain running Active Directory, you can click Find Printer to search for a printer on the network with the capabilities you want, such as high-speed or color printing. 

To store a document as a file rather than sending it to the printer, click the Print to file check box in the Print dialog box. 

For easy access to your printer, you can create a shortcut to it on the desktop. You can double-click the shortcut to open the print queue and view the documents waiting to print. 

You can print a document without opening it by dragging its icon to a printer in the Printers folder or to a shortcut on your desktop. 

While a document is printing, a printer icon appears next to the clock in the status area on the taskbar. When this icon disappears, it means that your document has finished printing. 
To connect to a printer on a network
 1.
Open Printers. 
 2.
Double-click Add Printer to start the Add Printer wizard, and then click Next. 
 3.
Click Network printer, and then click Next. 
 4.
Connect to the desired printer by: 

Searching for it in the Active Directory. 

Typing its name using the following format, or clicking Next to locate the printer on the network: 

\\printserver_name\share_name

Typing its URL using the following format: 

http://printserver_name/Printers/share_name/.printer
 5.
Follow the instructions on the screen to finish connecting to the network printer. 

The icon for the printer appears in your Printers folder.
Notes

To open Printers, click Start, point to Settings, and then click Printers. 

If you are not logged on to a Windows 2000 domain running Active Directory, the option to Find a printer in the Directory will not be available. 

Connecting to a printer using its URL allows you to connect to printers across the Internet providing you have permission to use that printer. 

If you cannot connect to your printer using the general URL format above, please see your printer's documentation or contact your network administrator. 

You can also connect to a printer by dragging the printer from the Printers folder on the print server and dropping it into your Printers folder, or by simply right-clicking the icon and then clicking Connect. 

After you have connected to a shared printer on the network, you can use it as if it were attached to your computer. 
To add a printer that is attached to your computer
 1.
Connect the printer to the appropriate port on your computer according to the printer manufacturer's instructions. 
 2.
Windows 2000 will automatically install most printers. However, for older printers, you may be required to provide additional information to complete the installation. Choose one of the following, depending on the type of printer you have. 

Install a parallel port (LPT) attached printer

If your printer attaches to your computer with a parallel port (LPT port), connect the printer to your computer, and then open Printers. Double-click Add Printer to start the Add Printer wizard, and then click Next. Click Local Printer, make sure the Automatically detect my printer check box is selected, and then click Next. Depending on the printer you are installing, a Found New Hardware message or the Found New Hardware wizard appears to notify you that the printer has been detected and that installation has begun. Follow the instructions on the screen to complete the printer installation. (You do not need to continue with the instructions below.)

Alternatively, after connecting your printer, you can start or restart your computer to allow Windows 2000 to automatically start the Found New Hardware wizard.

The printer icon will be added to your Printers folder. 

Install a USB or IEEE 1394 printer

If you install a universal serial bus (USB) or IEEE 1394 printer, Windows 2000 detects it and automatically starts the Found New Hardware wizard. You do not need to shut down or restart your computer. Simply follow the instructions on the screen to finish installing the printer. (You do not need to continue with the instructions below.)

The printer icon will be added to your Printers folder.

Install an infrared printer

If you install an infrared printer, Windows 2000 detects it and automatically installs it. You do not need to shut down or restart your computer. First, make sure that the infrared-enabled computer and the printer are turned on. Then, position the two infrared capable devices to within approximately 1 meter of each other to establish a wireless infrared connection. After several seconds the computer will recognize the printer, the printer icon will appear in the status area of the taskbar, and the appropriate drivers will be installed on the computer. (You do not need to continue with the instructions below.)

The printer icon will be added to your Printers folder.
 3.
If you could not install your printer using Plug and Play, or if the printer is attached to your computer with a serial (COM) port, then open Printers. 
 4.
Double-click Add Printer to start the Add Printer wizard, and then click Next. 
 5.
Click Local printer, make sure that the Automatically detect my printer check box is cleared, and then click Next. 
 6.
Follow the instructions on the screen to finish setting up the local printer by selecting the printer port, selecting the manufacturer and model of your printer, and typing a name for your printer. 

When you are finished, the icon for the printer appears in your Printers folder.
Notes

If you add and set up a Plug-and-Play printer (for example, USB, IEEE 1394, LPT, or Infrared), you do not need to have administrative privileges. However, to add and set up a non Plug-and-Play printer connected directly to your computer, you must be logged on as an administrator or a member of the Administrators group. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Printers, click Start, point to Settings, and then click Printers. 

When you add a printer using the Add Printer wizard, you normally select one of the parallel (LPT) ports from the Existing list when prompted to Select the Printer Port in step 6 above. For some plotters, however, you may need to select one of the serial (COM) ports. 

Once you have set up the printer, you can share it with other users on the network. If you intend to share the printer with users running other versions of Windows (Windows 95 and 98, and Windows NT 3.5 and 4.0), you can install the appropriate printer drivers on your computer so those users can connect to the printer without being prompted to install the drivers missing from their systems. 

If you want to print a test page, first make sure your printer is turned on and ready to print. 

If your computer does not support infrared technology, you can attach an infrared transceiver to your serial (COM) port, which will allow you to print over a wireless infrared connection. 
To specify your default printer
 1.
Open Printers. 
 2.
If you have more than one printer installed on your computer, right-click the printer you want to use as the default printer, and then click Set as Default Printer. 

A check mark appears next to the printer icon in the Printers folder.
Notes

To open Printers, click Start, point to Settings, and then click Printers. 

A check mark located next to the Set as Default Printer menu option indicates that you have selected the default printer. 

When you click Print on the File menu of many Windows-based programs, the default printer is used unless you specify otherwise. 
To set page orientation
 1.
Open Printers. 
 2.
Right-click the printer you are using, and then click Printing Preferences. 
 3.
On the Layout tab, under Orientation, click one of the following options: 

Portrait to print vertically on the page. 

Landscape to print horizontally on the page. 

Rotated Landscape to rotate the print 90 degrees counterclockwise on the page. 

A representation of your selection will appear in the display area of the dialog box.
Notes

To change printing preferences, you must have the Print permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

The Orientation options appear in the dialog box only if your printer supports this feature. The specific options available depend on the printer you are using. 

Any changes you make in Printing Preferences will alter the default document settings for the printer and will affect all documents you send to the printer. To change print settings for individual documents from within a program, click Page Setup (or Print Setup) on the program's File menu, and then make selections. 

To set the printing default for all users connected to the printer, see Set printing defaults. 
To specify paper size
 1.
Open Printers.
 2.
Right-click the printer you are using, and then click Printing Preferences. 
 3.
Click Advanced, and under Paper/Output click Paper Size. 
 4.
Click the paper size (form) you want. 
Notes

To change printing preferences, you must have the Print permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

Any changes you make in Printing Preferences will alter the default document settings for the printer and will affect all documents you send to the printer. To change print settings for individual documents from within a program, click Page Setup (or Print Setup) on the program's File menu, and then make selections. 

To set the printing default for all users connected to the printer, see Set printing defaults. 
To print on one or both sides of the paper
 1.
Open Printers. 
 2.
Right-click the printer you are using, and then click Printing Preferences. 
 3.
On the Layout tab, under Print on Both Sides (Duplex), click one of the following options: 

None to print on only one side of the paper. 

Flip on Short Edge to print on both sides of the paper with pages that are bound on the top edge. 

Flip on Long Edge to print on both sides of the paper with pages that are bound on the left edge. 

A representation of your selection will appear in the display area of the dialog box.
Notes

To change printing preferences, you must have the Print permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

The Print on Both sides (Duplex) options appear in the dialog box only if your printer supports this feature. The specific options available depend on the printer you are using. 

Any changes you make in Printing Preferences will alter the default document settings for the printer and will affect all documents you send to the printer. To change print settings for individual documents from within a program, click Page Setup (or Print Setup) on the program's File menu, and then make selections. 

To set the printing default for all users connected to the printer, see Set printing defaults. 
To print multiple pages per sheet
 1.
Open Printers. 
 2.
Right-click the printer you are using, and then click Printing Preferences. 
 3.
On the Layout tab, select the number of pages you want to print on a sheet in Pages Per Sheet. 

A representation of your selection will appear in the display area of the dialog box.
Notes

To change printing preferences, you must have the Print permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

The Pages Per Sheet option appears in the dialog box only if your printer supports this feature. 

Any changes you make in Printing Preferences will alter the default document settings for the printer and will affect all documents you send to the printer. To change print settings for individual documents from within a program, click Page Setup (or Print Setup) on the program's File menu, and then make selections. 

To set the printing default for all users connected to the printer, see Set printing defaults. 
To view documents waiting to print
 1.
Open Printers. 
 2.
Double-click the printer for which you want to view the documents waiting to print. 
Notes

To open Printers, click Start, point to Settings, and then click Printers. 

The print queue shows information about a document such as print status, owner, and number of pages to be printed. From the print queue, you can cancel or pause printing for any documents you have sent to the printer. 

You can also open the print queue for the printer on which you are printing by double-clicking the printer icon in the status area on the taskbar.
To pause or resume printing of a document
 1.
Open Printers.
 2.
Double-click the printer you are using, which opens the print queue. 
 3.
Right-click the document for which you want to pause or resume printing. 
 4.
Do one of the following: 

To pause printing, click Pause. 

The document will not print until you resume printing.

To resume printing, click Resume. 

The document will begin printing. However, if higher priority documents are waiting to print, they will print first.
Notes

By default, all users can pause, resume, restart, and cancel printing of their own documents. However, to manage documents printed by other users, you must have the Manage Documents permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

In general, once a document has started printing it will finish printing even if you pause it. 
To cancel printing of a document
 1.
Open Printers. 
 2.
Double-click the printer you are using, which opens the print queue. 
 3.
Right-click the document you want to stop printing, and then click Cancel. 
Notes

By default, all users can pause, resume, restart, and cancel printing of their own documents. However, to manage documents printed by other users, you must have the Manage Documents permission. 

To open Printers, click Start, point to Settings, and then click Printers. 

You can cancel the printing of more than one document by holding down the CTRL key and then clicking each document you want to cancel. 

You can also right-click the printer icon in the status area on the taskbar to open the print queue. 
To set printing defaults
 1.
Open Printers.
 2.
Right-click the printer for which you want to set the default printing preferences, and then click Properties. 
 3.
On the Advanced tab, click Printing Defaults. 
 4.
Click the Layout and Paper/Quality tabs and the Advanced button to see the available choices, and specify the default settings. 
Notes

You can change the default printing preferences only if you have the Manage Printers permission. For information about printing security permissions, see Related Topics. 

To open Printers, click Start, point to Settings, and then click Printers. 

The default preferences you set, which can specify options such as the page orientation, the tray from which paper is fed to the printer, and the number of copies to print, will be the default settings for any user who connects to this printer. Individual users can customize these settings by right-clicking a printer in the Printers folder, and then clicking Printing Preferences. 
